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l. SESSION OVERVIEW

Goals

>

>

>

Expose participants to some of the advanced features available in PowerPoint, including
the integration of multimedia files
Provide a roadmap for finding and using these features

Many of these features are available in Impress (OpenOffice), Key Note (Apple iWork), and
other presentation applications

Basic Guidance for PowerPoint

>

>

Though we are moving to the next level of PowerPoint, the basic rules for layout and
formatting still hold

For some basic principles for efficiently and effectively communicating information with
PowerPoint, including guidelines for format and design, refer to the document entitled
PowerPoint Presentations On Point listed in the Additional Resources section

We will be working with PowerPoint 2007 (PC), but | have provided the commands for
previous versions

Microsoft Microsoft PowerPoint Macintosh Equivalent
Office Version | Version
Office 2007*** PowerPoint 2007 *** PowerPoint 2008***
Office 2003 PowerPoint 2003 PowerPoint 2004
Office XP PowerPoint 2002 PowerPoint X

PowerPoint 2001

Office 2000 PowerPoint 2000 No Mac equivalent, but PowerPoint
(very similar to PowerPoint 97) | 98 (Mac) is basically the same

*** Major chan ges introduced here
Detailed information about the differences between each version, as well as equivalency
information for older versions, can be found at http://pptfag.com/FAQ00281.htm




Il. WORKING WITH IMAGES

For step-by-step instructions on how to build image-based PowerPoint presentations, please
see Eileen Fry’s Introduction to Creating Effective Image PowerPoint Presentations listed in the
Additional Resources section

Preparing Images for PowerPoint

>

>

Perform all image processing (cropping, color correction, resizing, etc.) outside of
PowerPoint—this should be part of the imaging workflow

Part of yourimaging workflow will include resizing images for different uses such as
projection

Images used in PowerPoint should match the dimensions of the projected space
Forexample, XGA projectors have 1024 pixels on the long side, so a horizontal image should
have 1024 pixels on the long side if it is to be displayed full-screen

Projector Type Pixel Dimensions Aspect Ratio
SVGA 800 x 600 Standard (4:3)
XGA 1024 X 768 Standard (4:3)
SXGA 1280 X 1024 Standard (4:3)
UXGA 1600 X 1200 Standard (4:3)
WVGA 854 x 480 Widescreen (16:9)
WSVGA 1024 X 576 Widescreen (16:9)
WXGA 1280 x 720 Widescreen (16:9)
WUXGA (FullHD) 1920x 1200 Widescreen (16:9)

» Images intended for use in PowerPoint should be saved as JPEG files

Importing Images
» Basic procedure forinserting animage:

Insert = Picture

Browse and Select Images
Prior Versions:

Insert = Picture = From File...

In PowerPoint 2002 or later, multiple images can be selected, BUT they will all be inserted
onto the current slide

Afterimages are selected, always press “Insert” instead of “Link to File”

If you do not insert images, a link to an external file is created and the path to the image
must be maintained (all images must be stored with the presentation)

If you are using images from another source (a webpage, another PowerPoint, etc.) do not
simply copy and paste

When animage is pasted into PowerPoint, extraneous data is pasted along with the image
which increases the size of the PowerPoint file

Download the full-size file and insert it as above to avoid inadvertently pasting a link



Batch Loading Images
» Toinsert multiple images onto multiple slides at once, you can create a "Photo Album”

Insert—> Photo Album
Prior Versions:
PowerPoint 2002 or later: Insert PPicture > New Photo Album
Versions prior to PowerPoint 2000 require the free
Microsoft Photo Album Add-In available at

http://office.microsoft.com/downloads/2000/album.aspx

Additional Image Tools

>

>
>
>

Additional Add-Intools are available for handling images (refer to the Add-Ins list inthe
Additional Resource section)

These offer more control and flexibility when working with images in PowerPoint
InsertPicture (for Mac) offers fast importing of images from many sources

Image Importer Wizard (for Windows) allows the insertion of multipleimages onto
presentation slides using user-defined templates



http://office.microsoft.com/downloads/2000/album.aspx

I1l. WORKING WITH MULTIMEDIA

Importing Audio/Video Materials

» Video files do not become part of the PowerPoint file, they are always linked—to avoid
linking issues, keep video filesinthe same folder as the PowerPoint presentation

» Rememberto copy both the presentation and the video files onto CDs, thumb drives, etc.

» Importing video files into PowerPoint is not always the best method to play videos: only
short video clips that support your presentation should be integrated into PowerPoint

» By default, PowerPoint links to audio files that are greater than 100 kilobytes

Insert Method

» Toinsert avideo file into a PowerPoint presentation:

Insert > Movie

Browse and select the video file to insert

Click OK

Chose whether the video startsimmediately when the slide loads or
whenitis clicked

Prior Versions:
Insert > Movies and Sounds = Movie from File...

» Toinsert anaudio file into a PowerPoint presentation

Insert 2 Sound

Browse and select the audio file to insert

Click OK

Chose whether the audio startsimmediately when the slide loads or
whenit is clicked

This will place a sound icon on the slide (can be moved off the slide)
Prior Versions:
Insert = Movies and Sounds = Sound from File...

Hyperlink Method
» Hyperlinksto videos can be created so that videos openin a player outside of PowerPoint
» Whenthelink onthesslide is clicked, the video launchesinthe default player for that video
type (QuickTime Player, Windows Media Player, etc.)
» The hyperlink method can also be used to launch webpages (it may take a moment or two
forthe browser to launch and the webpage to load)
Highlight or Select the text or object to be linked
Insert = Hyperlink
Click the foldericon on thetop-right corner to browse for the file
Select the video file that your presentation slide should launch
Click OK
Prior Versions:
Insert - Hyperlink
Select "Browse for File"

Select the video file that your presentation slide should launch
Click OK




Embedding Audio Files

» PowerPoint can be adjusted to embed sound files of a certain file size instead of linking
» This must be adjusted BEFORE any audio files are inserted into PowerPoint

» Embedded audio files will cause anincrease in the size of the PowerPoint file, but linking

issues can be avoided

Office Button > PowerPoint Options - Advanced
Under Save, increase the value next to "Link sounds with file size
greater than" to accommodate the size of the audio files to be
embedded (i.e. if you set the value to 5000 kb, sound files up to 5 mb
will be embedded into your presentation)
Click OK

Prior Versions:

Tools 2 Options > General

Increase the value next to "Link sounds with file size greater than" to

accommodate the size of the audio files to be embedded
Click OK

Audio/Video File Formats

>

YV V

Some file formats are proprietary and require a specific program be installed on your
computer (i.e. QuickTime (.mov) movies will only play if QuickTime isinstalled)

To maximize compatibility, non-proprietary file formats are recommended because they
can be opened in a variety of software environments

The best format to insert into PowerPoint presentations is MPEG files

The same holds true for audio files—the best choice is .mp3 files

Windows Media Files (.wmv) can also be inserted into Window PowerPoint, but they will
not play back in Macintosh PowerPoint

You cannot insert a QuickTime movie (.mov) into Windows PowerPoint

Proprietary File Formats for Audio/Video

File Type | Extension Description
Microsoft .avi, .wvm Windows Media formats for download or streaming include Audio
Video Interleave (.avi) and Windows Media Video (.wvm)
QuickTime .mov Native Macintosh file system; can be streamed or downloaded
Real Video .rm, .rv Streaming video architecture; can be encoded to support a range of
bandwidths
Non-Proprietary File Formats for Audio/Video
File Type | Extension Description
MPEG-1 .mpg, VHS quality; file size is approximately 10 MB per minute; most widely
.mpeg used format, therefore most video players can display
MPEG-2 .mpg, DVD quality; file size is larger at approximately 25-40 MB per minute
.mpeg
MPEG-3 (MP3) [ .mp3 CD Quality audio format; supported by most players
MPEG-4 .Mp4 Smallest MPEG video format with a corresponding loss of quality; file
size is ap proximately 3-5 MB per minute




The hyperlinking method above can be used if a file is not in the proper format

For example, you can link to a QuickTime movie (.mov) from a Windows PowerPoint
presentation, but Quick Time must be installed on the computer. Similarly, hyperlinked
Windows Media files (.wmv) work in a Macintosh PowerPoint presentation, but a compatible
Windows Media Player must be installed on the computer.

Using Flash Files in PowerPoint

>
>

>

Flash files can also be imported into PowerPoint, but the processis a bit more involved
Be aware that if Flash files are embedded into a presentation, a Flash player must be
installed onthe computer that will be used for the presentation

Here are step-by-step instructions forinserting Flash files. They require some familiarity
with PowerPoint developer controls:

How to Insert Flash into PowerPoint 2007
http://www.actionscript.org/resources/articles/672/1/How-to-insert-Flash -into-PowerPoint-2007/

How to Insert Flash into Previous PowerPoint Versions
http://www.brainybetty.com/HowtolnsertFlashin PPT.viewlet/HowtolnsertFlashinPPT launcher.html

Sources of Audio/Video — Digitizing an Analog Source

>
>

Below are the basic methods for digitizing analog sources (VHS, cassette tapes, etc.)
Ensure that your final product isin an appropriate digital file format for PowerPoint,
preferably MPEG


http://www.actionscript.org/resources/articles/672/1/How-to-insert-Flash-into-PowerPoint-2007/
http://www.brainybetty.com/HowtoInsertFlashinPPT.viewlet/HowtoInsertFlashinPPT_launcher.html

Digitizing Analog Video

Method 1 — Using a Digital Camera:

1. Connect the analog video player (i.e. VCR) to a digital
video camera/recorder using A/V cables

2. Play the video on the analog player while recording on the
digital recorder
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Analog Video Player A/V Cables Digital Video Recorder

3. Upload the digital recording onto the computer
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Digital Video Recorder Computer
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Method 2 — Using a Video Card Directly:

1. Connect the analog player directly to the computer using
a video card and encoding software
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Analog Video Player A/V Cables Computer




Digitizing Analog Audio

Method 1 — Using a Digital Audio Recorder:

1. Connect the analog audio player (i.e. tape deck) to a
digital audio recorder using A/V cables

2. Play the audio source on the analog player while recording

on the digital recorder
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Analog Audio Source A/V Cables Digital Audio Recorder

3. Upload digital audio recording to computer
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Digital Audio Recorder Computer

Method 2 — Using an Audio Card Directly:

1. Plug the analog player directly into the computer using an
audio card and encoding software
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Sources of Audio/Video — Web-Based Repositories of Multimedia for Teaching

» Please see the list in the Additional Resources section of web-based collections that
provide access to various multimedia resources, including audio files, moving images, and
presentations

» These objects can be downloaded to embed into PowerPoint or can be hyperlinked from
PowerPoint

What about Google and YouTube Videos?

» Aspecial utility, such as http://vixy.net, is required to capture videos from Google Video or
YouTube, and convert them to a specified file format such as MPEG

» These utilities allow you to save files from Google Video or YouTube to your desktop so
that they can be inserted into your PowerPoint presentations

» Thisraises copyright concerns, so | recommend consulting with your institution’s copyright
warden

» To besafe, link to Google Video or YouTube from presentations, and play the materials
within the original Web environment

» Ifavideois clearly free of copyright restrictions, instructions on how to capture it can be
found here: http://www.agentjim.com/MVP/YouTubeAndGoogle.htm



http://vixy.net/
http://www.agentjim.com/MVP/YouTubeAndGoogle.htm

IV. PRESENTATION & PROJECTION ISSUES

Compression & File Size Management

>

>

The size of a PowerPoint file increases in proportion to the number of embedded audio files
and the number of images it contains

Must strike a balance between the file size and the quality of the images—make sure that
images are not oversized for projected (refer to the projector resolution chart above)

Make sure that all images are edited outside of PowerPoint because changes made in
PowerPoint are saved as data (for example, when you crop animage in PowerPoint, it
retains all of the cropped areas of images)

Starting with PowerPoint 2002, the ability to compress all of the imagesin a presentation
was introduced

This function also removes extraneous data

This function will decrease the quality of yourimages, but can be used to reduce the file
size of your presentation if you need to post it to Blackboard/Sakai or to the Web

If you use this option, always save the compressed version as a separate file and retain an
original uncompressed presentation

To compress a PowerPoint presentation:

Click the Save button (or go Office Button - Save)
Click the Tools drop down menu located in the lower left corner
Select "Compress Pictures”
Click “*Options”
Check “"Automatically perform basic compression on save”
Check “"Delete cropped areas of pictures”
Click OK
Prior Versions:
Click File 2 Save As
Click the Tools drop down menu
Select "Compress Pictures”

Select "All Pictures in document”
Select "Compress pictures” and "Delete cropped areas of pictures”

Click OK

Add-Ins are available to help compress and optimize your presentation, such asthe
PPTools Optimizer available at http://www.pptools.com/optimizer/index.html

Thistool creates copies of presentations that are sized for specific needs and removed of
extraneous data



http://www.pptools.com/optimizer/index.html

Packaging your Presentation & Using PowerPoint Viewer

» PowerPoint can “package” your presentation to save on a CD, a thumbdrive, or a network
drive (this solution replacesthe “Pack and Go"” wizard that was part of previous versions)

» Process ensures that all necessary external files (such as videos) are saved in one folder
which can be burned to CD orsaved on a drive

» By default, this process also saves the PowerPoint Viewer with presentations

» PowerPoint Viewer allows presentations to be shown on computers that do not have
PowerPoint installed

Office Button = Publish - Package for CD
Alist of files to be included will appear, but click “Add Files...”
to select additional files
To save the presentation filesto a CD, click "Copy to CD”
To save the presentation in a folder to move onto a network drive or
thumb drive, click "Copy to Folder...”
Prior Versions:
File > Package forCD...
Versions prior to PowerPoint 2003:
File > Pack and Go...

Embedding Fonts with Your Presentation

» To ensure that fonts are saved with a presentation:

Click the Save button (or go Office Button - Save)

Click the Tools drop down menu located inthe lower left corner
Select “Save Options...”

Ensure that "Embed fonts in the file” is selected

Click OK

Prior Versions

Click File = Save As

Click the Tools drop down menu

Ensure that "Embed fonts in the file” is selected
Click OK

» Some PowerPoint Presentations are saved as “.pps” files

» These are PowerPoint Shows—they always open in Slide Show view automatically
» To create a PowerPoint Show file:

Office Button - Save As = PowerPoint Show




Posting Presentations to the Web
» PowerPoint presentations can be posted to the Web in two ways:

1. Simply upload the PowerPoint file to your web space and the address will be:
http://www.institution.edu/mywebspace/mypresentation.ppt
When this address is typed into any browser, the file will be downloaded and will open in
PowerPoint (this will only work if the destination computer has PowerPoint installed).
This method does not work if there are additional files external to the presentations, such
as videos.

2. Presentations canalso be saved as webpages. These canthenbe uploaded asa
standard web page and can be accessed on any computer (PowerPoint does not need
to beinstalled). When you do this, there will be a main web file and a folder that
contains the additional assets for the presentations (images, etc). Itisimportant that
these two components are uploaded together.

Office Button - Save As

Select "Web Page” from the “Save as Type” drop down menu
To give the web page atitle, click "*Change title...”

Click "Publish...” and make sure that "Complete presentation”

isselected
Prior Versions
File > Save as Web Page...

Dual Screen Projection

» Todisplay a presentation on two screens intwo different views (for example, one monitor
displays notes, while a PowerPoint presentationis projected on a screen), Dual Monitor
Mode is used

» InPowerPoint 2007, this can be setup by using Presenter View which allows you to project
the full-screen presentation onto one monitor while viewing the Speaker View on another

Slide Show > Click Presenter View in the Monitors section
Select the screenresolution to use for the full-screen presentation

Previously, a computer had to be configured to recognize two monitors using the
system’s "Display Properties” outside of PowerPoint. To configure your comp uter,
go to the Control Panel in the Start Menu and click on Display. On the Settings tab,
you can select the dual monitor mode and adjust how your desktop is displayed.
Then in PowerPoint, go to

Slide Show - Set Up Show

In the "Show on” list, select the monitor the slide show should appear on




Side-by-Side Projection
» There are three (or more) ways to present two images side-by-side

1.

The Obvious, Simple Solution

Simply insert two images per slide and resize them to fit on one slide

This simple solution is desirable because only one PowerPoint presentation and only one
digital projector are necessary. However, each image is only half as large as usual.

The Less Obvious, Simple Solution

Similartothe first method, a single PowerPoint presentation is created, but in
widescreen mode. This offers more space to work with images. The widescreen
presentation can be projected onto two normal square screens with just a little space in
the middle.

Only one PowerPoint presentation and only one digital projector are needed, however you
must test extensively until the spacing is correct.

The More Elegant, More Complicated Solution

Two digital projectors can be run off of one computer if a multiple display/dual video
card isinstalled (these costs between $200-$250). Two PowerPoint presentations must
be prepared and projected using separate digital projectors on two small screens orone
large screen.

It can be difficult to control the two PowerPoint presentations, however there is an Add-In
which costs about $100 that will allow you to run different presentations on different
monitors or projectors. Itis called OfficeOne PowerShow 6.8 and is available at:
http://officeone.mvps.org/powershow/powershow.html



http://officeone.mvps.org/powershow/powershow.html

Compatibility Issues

» If possible, always test a presentation onthe destination computer and projector

» Ifthisisnot possible, determine the configuration (platform and PowerPoint version) of the
presentation computer and test your presentation under those conditions

Issues Related to Platform (Macintosh and PC) Differences
» There are a number of differences when a presentation is moved between platforms
» Ingeneral, the following guidelines should be followed:
v Always name your files carefully. Do not use spaces or punctuation marks. Keep your
file names simple.
v" If you create images on a Macintosh, make sure you do not create QuickTime-
compressed images. These will not work ona PC.
v" Remember to stick to non-proprietary file formats. QuickTime movies seldom work on
PCs, so use MPEG filesinstead.
v’ Be sure that yourimages are embedded, not linked. Linksto images will inevitably
break when you move from platform to platform
v Fontsdiffer between the two platforms. Make sure that you embed your fontsinto
your presentation, but realize that font substitution and slight differences in text
rendering may occur. If text is squeezed too tightly into text boxes, it may get
truncated.
» Foramore complete discussion of these issues go to http://pptfag.com/FAQ00281.htm.

Issues Related to PowerPoint Version Differences
» There are many resources that document the differences between the various PowerPoint
versions, including http://www.wiseowl.co.uk/ms-training-version/training-microsoft-
powerpoint.htm which contains links to graphical presentations of the changesin
PowerPoint 2000, PowerPoint XP, PowerPoint 2003, PowerPoint 2007

As noted, PowerPoint 2007 is vastly different from all of the previous versions
Thisincludesthe file extension which is now .pptx by default

If you are unsure if the destination computer has been upgraded to PowerPoint 2007, save
your file as a .ppt file:

Office Button - Save As...

Select "PowerPoint Presentation 97-2003" under "Save as Type”

YV VYV

» The main authority on finding new commands in PowerPoint 2007 is the Microsoft Office
website-- the page entitled Interactive: PowerPoint 2003 to PowerPoint 2007 Command
Reference Guide located at http://office.microsoft.com/en-us/help/HA101490761033.a5px
contains interactive demos, downloadable guides, links to articles on specific topics, and a
wealth of tips

» The Office PowerPoint 2007 Ribbon Mapping Workbook is an Excel workbook that translates
the various commands in previous versions to PowerPoint 2007. It is available at
http://office.microsoft.com/en-us/powerpoint/HA100666231033.aspx. Scroll all the way
down the page to New Locations of Familiar Commands. Click onthe link forthe Ribbon
Mapping Workbook.



http://pptfaq.com/FAQ00281.htm
http://www.wiseowl.co.uk/ms-training-version/training-microsoft-powerpoint.htm
http://www.wiseowl.co.uk/ms-training-version/training-microsoft-powerpoint.htm
http://office.microsoft.com/en-us/help/HA101490761033.aspx
http://office.microsoft.com/en-us/powerpoint/HA100666231033.aspx

Preparing for Widescreen

>
>
>

Until recently, most presentations were projected with the standard 4:3 aspect ratio
Institutions are now installing widescreen format projectors with an aspect ratio of 16:9
Moving to widescreen can be desirable: there will be more room forimages and side-by-
side comparisons can be satisfactorily achieved on one slide

It is not difficult to create PowerPoint presentations for widescreen projection--it is simply
a matter of resizing the slides to the new aspect ratio

This must be done BEFORE any content is added to the presentation. If slides are
resized after images are added, they will be distorted!

Design - Page Setup
Under “Slides sized for” select "On-screen Show (16:9)"
This changes the dimensions of the slides

Prior Versions:

File 2 Page Setup

Chose "Custom” next to "Slides sized for:”

Change Width to 10 inches

Change Height to 5.63 inches




V. OTHER USEFUL TOOLS

Creating a Self-Running Presentation

>
>
>

Presentations that run by themselves are useful for poster presentations and the like
They canbe silent or narrated

To record a narration, your computer must be equipped with a sound card, microphone,
and speakers

Commands for recording a narration are located in the “Slide Show” tab under “Set Up”
To program a presentation to run continuously, set the slides to advance automatically:

Animations 2 Advance Slide

Select "Automatically after” and set an appropriate time
Select “"Apply to All”

Then run the presentationin kiosk mode:

Slide Show - Set Up Show

Under Show Type, select "Browsed at a kiosk (full screen)”
For more information, see:

http://office.microsoft.com/en-us/powerpoint/HA010348171033.aspx

Store, Share, and Reuse Slides using "Slide Library”

>
>

PowerPoint 2007 allows slides to be published to a “Slide Library”

Using Slide Library, you can store slides in a shared, central location for others to access,
track and review changesto slides, locate the latest version of a slide, and add slides from
the Slide Library to your presentation

To use Slide Library, your computer must be running Microsoft Office PowerPoint 2007 and
it must be connected to a server running Microsoft Office SharePoint Server 2007

For more information, see:
http://office.microsoft.com/en-us/powerpoint/HA012261671033.aspx



http://office.microsoft.com/en-us/powerpoint/HA010348171033.aspx
http://office.microsoft.com/en-us/powerpoint/HA012261671033.aspx

Keyboard Shortcuts

Keyboard Shortcuts for PowerPoint
(Many are the same for Macs, simply use the command key instead of CTRL)

Insert a new slide CTRL+M
Make a duplicate of the current slide  CTRL+D
Start a slide show Fsg

Promote a paragraph

ALT+SHIFT+LEFT ARROW

Demote a paragraph

ALT+SHIFT+RIGHT ARROW

Apply subscript formatting

CTRL+EQUAL SIGN (=)

Apply superscript formatting

CTRL+PLUS SIGN (+)

Open the Font dialog box

CTRL+T

Repeat your last action F4 or CTRL+Y
Find CTRL+F

View guides CTRL+G
Delete a word CTRL+BACKSPACE
Capitalize SHIFT+F3
Bold CTRL+B
Italicize CTRL+I

Insert a hyperlink CTRL+K
Select all CTRL+A
Copy CTRL+C
Paste CTRL+V
Undo CTRL+Z

Save CTRL+S

Print CTRL+P
Open CTRL+O

For a full list of keyboard shortcuts for PowerPoint, go to
http://www.bitbetter.com/powerkeys.htm

PowerPoint Presenters

» PowerPoint presenters are laser pointers that can control PowerPoint presentations

» They work using a receiver connected to a USB port

» There are two types:

Beta Electronics makes a pen-shaped laser pointer that also controls PowerPoint:
http://www.betalaser.com/powerpoint.htm

Targus makes a Wireless Presenter with Laser Pointer that is more like a remote control

(available from Amazon)

T2



http://www.bitbetter.com/powerkeys.htm
http://www.betalaser.com/powerpoint.htm

V1. ADDITIONAL POWERPOINT RESOURCES

Major Resources

>

Microsoft Office PowerPoint Page

http://office.microsoft.com/powerpoint

Microsoft’s main PowerPoint website. Offers training, tutorials, demos, templates,
webcasts and more.

Mactopia PowerPoint Page
http://www.microsoft.com/mac/ (click on *PowerPoint”)
Microsoft’s main PowerPoint for Macintosh website. Offers help, how-to's, and downloads.

123PPT.com's PowerPoint Tips and Tricks
http://www.123ppt.com/powerpoint-tutorials/

A well-designed, easy-to-use site that offers PowerPoint tips, techniques, and brief
tutorials. Topics include PowerPoint & Graphics, PowerPoint & Sound, and PowerPoint &
Video.

About.com’s Presentation Software Section by Wendy Russell
http://presentationsoft.about.com/

Offers easy-to-follow, step-by-step instructions for accomplishing elementary to advanced
functionsin PowerPoint. Fully updated for PowerPoint 2007, but instructions for previous
versions are still maintained. Includesa PowerPoint 101 course.

Indezine by Geetesh Bajaj

http://www.indezine.com/

A huge PowerPoint resource with a search utility. Includes an active blog and helpona
large number of topics. Special sections for PowerPoint and Flash, review of PowerPoint
Books, and PowerPoint templates.

Macintosh PowerPoint Page by Jim Gordon
http://www.agentjim.com/MVP/PowerPoint/PPTHome.html

Site specifically for users of Macintosh PowerPoint. Contains how-to articles and several
useful Add-Ins.

OnPPT.com

http://www.onppt.com/

A great resource for assistance on more advanced topics such as playing musicin HTML
presentations, using PowerPoint in dual monitor/projector mode, creating PowerPoint
animations, etc.

PowerPoint FAQ

http://www.pptfag.com/index.html

Thisisthe main PowerPoint FAQ page, covering every imaginable topic. Questions are
organized by broad topic such as working with sound and movies, distributing and
delivering presentations, video projectors and dual monitors, and animation.



http://office.microsoft.com/powerpoint
http://www.microsoft.com/mac/
http://www.123ppt.com/powerpoint-tutorials/
http://presentationsoft.about.com/
http://www.indezine.com/
http://www.agentjim.com/MVP/PowerPoint/PPTHome.html
http://www.onppt.com/
http://www.pptfaq.com/index.html

PowerPoint Heaven

http://pptheaven.mvps.org/

An amazing website showcasing advanced use s of PowerPoint. Mainly an entertainment
portal for PowerPoint animations, games, artworks, and animation, but also provides
templates and tutorials.

Presentation Helper

http://www.presentationhelper.co.uk

A wealth of information about every stage of developing and delivering a presentation.
Offerstemplates, delivery advice, a great tips-and-tricks section, and a helpful forum.

General Instructions & Tutorials

>

Introduction to Creating Effective Inage PowerPoint Presentations by Eileen Fry
http://arch.ced.berkeley.edu/resources/avrl/present.html (clickon “Eileen's Image
PowerPoint")

Provides step-by-step instructions for creating image-based PowerPoint presentations
using screenshots.

PowerPoint in the Classroom Tutorial for PowerPoint 2007 by ACT360° Media Ltd.
http://www.actden.com/pp2007/
lllustrated, fun, step-by-step guide to using PowerPoint 2007. Especially good for students.

PowerPoint in the Classroom Tutorial for PowerPoint 2003 by ACT360° Media Ltd.
http://www.actden.com/pp2003/
lllustrated, fun, step-by-step guide to using PowerPoint 2003. Especially good for students.

PowerPoint Presentations On Point: General Guidelines for PowerPoint Presentation
Writing, Design, Text, Graphics and Color by North Carolina A&T State University
http://www.ag.ncat.edu/communications/onthepoint.pdf

A concise PDF document that outlines the basic principles for efficiently and effectively
communicating information with PowerPoint, including guidelines for format and design.
Especially useful for students.

Topic-Specific Instructions

>

How to Insert Flash into PowerPoint 2007
http://www.actionscript.org/resources/articles/672/1/How-to-insert-Flash-into-
PowerPoint-2007/

How to Insert Flash into PowerPoint (Prior Versions)
http://www.brainybetty.com/HowtolnsertFlashinPPT.viewlet/HowtolnsertFlashinPPT laun

cher.html

PowerPoint Tips and Tricks for Working with Sound in PowerPoint
http://www.123ppt.com/powerpoint-tutorials/powerpoint-tips-sound-music.asp



http://pptheaven.mvps.org/
http://www.presentationhelper.co.uk/
http://arch.ced.berkeley.edu/resources/avrl/present.html
http://www.actden.com/pp2007/
http://www.actden.com/pp2003/
http://www.ag.ncat.edu/communications/onthepoint.pdf
http://www.actionscript.org/resources/articles/672/1/How-to-insert-Flash-into-PowerPoint-2007/
http://www.actionscript.org/resources/articles/672/1/How-to-insert-Flash-into-PowerPoint-2007/
http://www.brainybetty.com/HowtoInsertFlashinPPT.viewlet/HowtoInsertFlashinPPT_launcher.html
http://www.brainybetty.com/HowtoInsertFlashinPPT.viewlet/HowtoInsertFlashinPPT_launcher.html
http://www.123ppt.com/powerpoint-tutorials/powerpoint-tips-sound-music.asp

PowerPoint Add-Ins
Add-Ins are small programs that attach to PowerPoint to expand its functionality and enhance
its features.

>

Image Importer Wizard (for PCs)

http://skp.mvps.org/iiw.htm

Allows the insertion of multiple images onto presentation slides using user-defined
templates

InsertPicture (for Mac)

http://www.agentjim.com/MVP/PowerPoint/ppt2004.htm

(Make sure to download the correct version of InsertPicture for your version of PowerPoint)
Offers fast importing of pictures from many image sources

Microsoft Photo Album Add-In
http://office.microsoft.com/downloads/2000/album.aspx.

Required to create Photo Albums (import multiple images onto multiple slides) in
PowerPoint versions prior to PowerPoint 2000

OfficeOne PowerShow 6.8
http://officeone.mvps.org/powershow/powershow.html
Allows you to run different presentations on different monitors or projectors

PowerPoint Add-Ins by Shyam Pillai
http://skp.mvps.org/download.htm
Various Add-Ins, including a Handout Wizard for PowerPoint, YouTube Video Add-In, etc.

PPTools

http://www.pptools.com/index.html

Alarge collection of powerful PowerPoint add-ins, including the Image Export and
Optimizer, which creates copies of presentation that are sized for specific needs and are
removed of extraneous data

Forums
These forums allow you to post questions about PowerPoint. Frequently you will receive a
number of helpful answers within a short period of time.

>

>

Bit Better’s PowerPoint Forum
http://www.bitbetter.com/phpBB3/

Presentation Helper’s PowerPoint Forum
http://www.presentationhelper.co.uk/Forum/
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VIl. WEB-BASED REPOSITORIES OF MULTIMEDIA FOR TEACHING

>

Gateway to Educational Materials (GEM)
http://www.thegateway.org

Provides educators with access to thousands of multimedia resources for a range of
education levels. Can be browsed by subject, such as “Arts,” and is full -text searchable.

Internet Archive
http://www.archive.org

Provides access to a library of cultural artifacts in digital form. The Moving Image Collection
includes various collections like the Prelinger Archives, Lutz Mommartz Film Archive, BBC
Documentary Video Collection, and Independent Video Archive. Also provides a Live Music
Archive, a Software Archive, and Web Archives.

Library of Congress American Memory Collection
http://memory.loc.gov/ammem/

Offersfifteen collections of digitized films.

Library of Congress Global Gateway: World Culture & Resources
http://international.loc.gov/intldl/intldlhome.html

Bilingual, multimedia digital libraries, built with partners from around the world.

Library of Congress Teacher's Portal
http://www.loc.gov/teachers

Providing access to more than ten million primary sources for all education levels.

Moving Image Collections (MIC) Database
http://mic.imtc.gatech.edu/index.php

Collocates catalog records for moving images from repositories around the world. Some
materials are available forimmediate download or streaming. Explore using subjects such
as “Art, Photography, and Architecture” or through form/genre such as “Exp erimental.”

Open Video Project Collection
http://www.open-video.org

Makes available a repository of digitized video content with collections including CHI Video
Retrospective, Digital Himalaya Project, the Informedia Project at Carnegie Mellon
University, and the University of Maryland Open House Video Reports.

Virtual Library Audio Repository
http://archive.museophile.org/audio/

A major resource for locating a variety of different audio materials as well as information
about computer-based audio and associated software.

WikiMedia Commons-Art Category
http://commons.wikimedia.org/wiki/Category:Art

Gateway to a wealth of multimedia materials, including animations, audio, and video files.


http://www.thegateway.org/
http://www.archive.org/
http://memory.loc.gov/ammem/
http://international.loc.gov/intldl/intldlhome.html
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